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Release Notes for RobotStudio 2025.1

General

The release name is RobotStudio 2025.1 and the build number is 25.1.11133.0. The build date is March 5,
2025.

User documentation

Documentation for RobotStudio, RobotWare and add-ins can be accessed from the Help page.

RobotStudio

The RobotStudio Operating Manual is available in all languages supported by RobotStudio except Czech,
i.e. English, German, French, Italian, Chinese, Japanese, Spanish.

RobotWare

RobotWare manuals for IRC5 and OmniCore are included in the RobotWare distributions that can be
installed from the Add-Ins Gallery.
Release notes for RobotWare can be accessed from the Help page or the Add-Ins Gallery.

Tutorials

Tutorials are available at the RobotStudio product pages at
https://new.abb.com/products/robotics/robotstudio.

System Requirements

Required Software

Microsoft Windows 10 Anniversary Edition or later, 64-bit edition, is required.

The Windows App Installer is a pre-requisite for the virtual OmniCore FlexPendant software, see
https://www.microsoft.com/en-us/p/App-Installer/9NBLGGH4NNS1. The App Installer is a default built-
in app in Windows 10 and later, but may have been removed on some PCs.

Sideloading of apps must be enabled on Windows to install the virtual OmniCore FlexPendant.

To enable sideloading follow these steps:

1. Open Settings.
2. Click Update & Security (Windows 10) or Privacy & security (Windows 11) > For developers.
3. Ensure Developer Mode is set to On.

Recommended Hardware

ITE M RE QUIRE ME NT

CPU 2.0 GHz or faster processor, multiple cores recommended

Memory
8 GB minimum
16 GB or more if working with large CAD models

Disk 10+ GB free space, solid state drive (SSD)

Graphics
Card¹

High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors.
For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.
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Screen
Resolution

1920 x 1080 pixels or higher is recommended

Mouse Three-button mouse

3D Mouse Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com.

Virtual
Reality
Headset

Meta Quest 2, HTC Vive or any Windows Mixed Reality Headset. Note that special PC hardware
requirements apply when using RobotStudio with VR, see https://www.oculus.com/oculus-ready-
pcs/, https://www.vive.com/us/vive-ready/, or, https://www.microsoft.com/en-us/mixed-
reality/windows-mixed-reality, respectively.

ITE M RE QUIRE ME NT

¹ RobotStudio will not benefit from the additional features of so-called ‘Professional’ or ‘Workstation’
graphics cards. The price level of these are at a much higher range than gaming graphics cards with
comparable performance. High-end gaming PCs are very suitable for offline programming with
RobotStudio. Such a PC will provide good performance for a limited budget.
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New Functionality

Show Signal and Property Groups in Station Logic

Single Joint Mover Smart Component

ACIS 2025 support

Freehand move World Zones

Jog TCP functionality separated from Move and Rotate

Mesh Modeling

Multi-object support in Smart Component sensors

Reorder Smart Component signals and properties

Use AR Viewer scans and other attachments from Cloud projects

Show Signal and Property Groups in Station Logic

Previously, the groups of signals and properties have only been visible in the property editor for smart
components. We have now added the groups to the Station Logic view as well. They are displayed as
headers, and the signals and properties are grouped below their respective group header.

Single Joint Mover Smart Component

A new Smart Component called SingleJointMover has been introduced, allowing users to move a single
joint. This complements the existing JointMover, which is designed for managing multiple joints.

ACIS 2025 support

The latest version of the ACIS engine has been integrated to ensure compatibility with current CAD
formats.

Freehand move World Zones

It is now possible to move World Zone volumes in the 3D graphics using the Move and Rotate tool.
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As for visualization, this is limited to World Zone instructions that use numeric literals in the volume
definition.

Jog TCP functionality separated from Move and Rotate

In RobotStudio 2023.2 the functionality for "Jog Linear" and "Jog Reorient" was combined with the
"Move" and "Rotate" tools. Later in RobotStudio 2023.4 the new more powerful "Move and Rotate" tool
was introduced that combined all of the previous four functionalities, supporting both jogging of the
robot and moving objects in the station.
 
The feedback regarding the new "Move and Rotate" tool was mainly positive, but from the feedback it
also became clear that it was easy to accidently move the robot or other objects in the station when
the intention was to jog the robot.
 
To clearly indicate the active operation, the functionality for jogging the robot by moving or rotating
the TCP (Tool Center Point) has been separated from the "Move and Rotate" button and assigned to a
new "Jog TCP" button.
 

 
When the "Jog TCP" tool is active and the robot mechanism or any of its links or the attached tool is
selected, the robot can be jogged just like before by moving or rotating the TCP using the handles in
the graphics window.
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As a consequence, the "Move and Rotate" tool can no longer be used for jogging the robot, but will only
move and rotate objects in the station. To move a robot using the "Move and Rotate" tool, you now
need to select the robot mechanism.

Mesh Modeling

This release introduces Mesh Modeling which is intended for working with large 3D models without CAD
geometry, typically AR Viewer scans.
It has the following functionality:

Edit the mesh by deleting, cutting or copying a selection of the mesh.
Reconstruct geometry (for example a plane) from a selection of the mesh.
Create splines, polylines or targets aligned with the mesh surface.

To launch Mesh Modeling, select a part in the layout and select Modify - Edit Mesh from the context
menu.
For further information see the product documentation.

Multi-object support in Smart Component sensors

Volume, Plane and Line sensors now have a new check box 'SenseMultiple' and a new output signal
'SensorOutPulse'. When 'SenseMultiple' is enabled, the 'SensedPart' and 'SensorOutPulse' will be set once
for all the objects that enter the sensor area when the sensor is active. This functionality can for
example be used to attach all the objects within the sensor area to a robot.
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Reorder Smart Component signals and properties

Smart Component signals and properties can now be reordered in the "Signals and Connections" and
"Properties and Bindings" tabs. Select one or more signals and click Move Up/Down. The new order of
the signals and properties is also reflected on the Smart Component in the "Design" tab.
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Use AR Viewer scans and other attachments from Cloud projects

It is now possible to download and import RobotStudio AR Viewer scans and other attachments from a
RobotStudio Cloud project.
Downloaded attachments are saved in the Attachments folder under the project folder.
Attachments can be accessed in two ways when a Cloud project is open:

In the Documents window, there is a new location called Cloud Attachments.

Here all attachments in the project are listed. A download icon is displayed for files that have not
been downloaded to the PC. The context menu can be used to download, open and view
information about the attachment.

Under Import Geometry, there is a new menu called Cloud Attachments.
Here only file types that can be imported into the project are displayed.
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Improvements

Confirm uncheck of Autoload for built-in Add-ins

The user is now asked for confirmation when unchecking the Autoload option for built-in RobotStudio
Add-ins. This is to ensure that core functionality such as Visual SafeMove and I/O Engineering is not
disabled by mistake.

Freezing and stuttering when opening AutoPath

Fixed an issue that caused RobotStudio to become unresponsive and stutter when moving the cursor
with the AutoPath tool open, with stations that contained certain complex geometrical shapes.

Modify Position for targets and joint targets

The Modify Position function which moves a target to the current TCP is now available for targets and
joint targets in addition to move instructions.

Progress when uploading to RobotStudio Cloud

When performing a commit or uploading a viewer to RobotStudio Cloud, the progress of the operation
is now shown in more detail.

Warning displayed when installing add-ins from the file system

A warning dialog is now shown when installing an add-in by browsing for it on the file system, informing
the user about potential risks.
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Information

Integrated Vision as separate installer

Integrated Vision will now be available as a separate installer. You can download it from the Add-Ins
Gallery in RobotStudio. It will no longer be included in the default RobotStudio installation.

© Copyright 2024 ABB. All rights reserved. 12/29



Corrections

Invalid characters in virtual controller name

When creating an OmniCore Virtual Controller, the validation of the controller name has been corrected. Allowed
characters in the name are "A-Z", "a-z", "0-9", "-" (hyphen), and "_" (underscore).

Base Frame check on startup incorrect

An issue where RobotStudio could incorrectly indicate at startup that a robot's station base frame does not align
with the base frame in the virtual controller has been resolved.

Uploading & opening project from cloud fails

Fixed an issue where uploading and opening the newly uploaded project from the cloud would sometimes fail.
This could happen for projects with multiple controllers due to a bug that occurred when creating systems in
parallel.

Error when creating OmniCore Virtual Controller from a backup with 

Fixed an error that could occur when creating an OmniCore Virtual Controller from a backup with two or more
robots of the same type.

Smart Component editor exception when trying to delete binding

Fixed an exception that could occur when trying to delete a property binding that was left over after deleting an
ExpressionBinding component.

Exception when selecting unlicensed option in Change Options

The error handling in Change Options for a RobotWare 6 Virtual Controller has been improved. Trying to select an
option for which there is no license in the controller will no longer result in an exception.

Downgrade results in corrupt installation

Installing RobotStudio when a newer build of the same major version is already installed (e.g. installing
RobotStudio 2024.3 over 2024.4) could result in a corrupt installation. This is no longer allowed without
uninstalling the newer version first.

Project Curve on surface

Project curve on surface will now work correctly in the case where the local origin of the curve to be projected has
been changed. This would previously cause problems.

Rename Controller Fails

Fixed an issue where Rename Controller would sometimes fail with a "Mastership rejected" error.

Loading Pack & Go with RobotWare upgrade results in safety errors

When loading a Pack & Go with a V250XT Virtual Controller based on RobotWare 7.11 or lower and updating to 7.12
or higher, a safety error could occur in the controller. This issue has been fixed.

Wrong event log message when changing RAPID variable

Corrected the formatting of the event log message that is raised when a variable is modified in for example RAPID
Watch. Previously, the message could be incorrect for array and string variables.
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Fatal error when loading project

Fixed a crash that could occur when loading a project with one or more corrupt files. The load will now fail
gracefully or result in an incomplete station, depending on the type of corrupt files.

Exception after converting to Move Circular

Fixed an error that could occur after performing "Convert to Move Circular" from the Instruction Tools context
tab.

Fatal error in add-in

Fixed a crash that could occur if a RobotStudio add-in threw an exception in the handler for certain API events.

RAPID Watch - Unresponsive UI when watching big RAPID variables

If a big RAPID variable (for example a byte array of 500) was added to the watch window it resulted in a
unresponsive UI and a busy virtual robot controller.
This is now solved with an overall performance improvement when the watch window is used, with the downside
that very big RAPID variables can no longer be observed.

Fatal error when opening Visual SafeMove 1 with two tools with the same name

Fixed an issue which would cause a fatal error upon opening Visual SafeMove 1 if there were two tools with the
same name in the station. The error could also occur when typing in the search bar.

Set Normal to Surface fatal error

Fixed a crash that could occur when performing "Set Normal to Surface" with certain geometries.

Meeting - Insufficient memory error

Fixed a memory leak and crash that could occur when creating or joining a Meeting.

Signal Analyzer: Only 11 signals can be selected

Fixed an issue in Signal Analyzer Online, where only 11 signals could be selected in signal setup.

Installation Manager 6 can handle Windows usernames containing non-ascii characters

Issues related to Installation Manager 6 run by a Windows user with a username containing other characters than
A-Z or 0-9 are now resolved.

Incorrect snapping for linear and planar jogging

When using linear or planar jogging with snapping enabled in the graphics window the TCP snapped to edges or
corners according to the selected snap mode. This modified the TCP position along other axes than only the
selected one, which was not an expected behavior. The TCP snapping has been disabled for linear and planar
jogging.
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Known Limitations

IO Configurator 6

*Safety configuration problem with PROFIsafe Controller or CIP-Safety scanner

Changing safety settings in Visual SafeMove or IO Configurator 6 does not always work in conjunction
with the "PROFISafe controller" or "CIP-Safety Scanner" option. Connection with robot controller can be
lost during any IO-configuration, sometimes resulting in that the Flex Pendant reboots. Again this is only
applicable when the PROFISafe controller or CIP-Safety scanner option is present in the system. Problem
is dependent on how many devices are configured on respective industrial network. I.e. EtherNet/IP or
ProfiNet.

Online

Signal Analyzer Online recordings not saved

When recording signals from a real controller with RobotWare 6.13.03 and later, or RobotWare 7.6.1 and
later, there is a sporadic issue which causes the signal changes to not be recorded.

Routine variables can't be displayed in RAPID Watch with RobotWare 6.12

A limitation in RobotWare 6.12 prevents variables declared in a routine from being displayed in the RAPID
Watch window.

Port speed cannot be set at the same time as 'Obtain IP address automatically'

In the Public Network settings dialog the Port speed drop down menu is disabled when 'Obtain IP
address automatically' is selected.

Workaround:

1. Select 'Use the following IP address' and specify any valid IP address.
2. Select the desired port speed and press OK.
3. Select 'Obtain IP address automatically' and press OK.

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later. However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to
stop can be selected from RobotStudio RAPID tab.

FlexPendant Viewer running with automatic reloading

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time
jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

Cable harness not visible in Online Monitor

Physics-based dynamic cables that are part of a robot model are not visible in Online Monitor.

Online – Paint

Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system
when running RobotWare 5.xx. Workaround: Create the backup of the PIB board with the FlexPaint
Pendant using an USB-stick.
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Go Offline does not work for Paint systems

The Go offline function will not create a working Virtual controller system for Paint system unless the
Paint package I/O option is set to Simulated.

Online – Integrated Vision

Installation error when having previous versions of RobotStudio or Insight Explorer

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new
version of RobotStudio may result in the following error message

Module C:\Program Files (x86)\Common Files\Cognex\InSight\5.7.1674.0\CvsInSightDisplay.ocx failed
to register. HRESULT -2147220472. Contact your support personnel.

Workaround: To correct the issue, open Windows Settings -> Apps -> Apps & features, select the
current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select
Repair. Alternatively, uninstall and reinstall RobotStudio.

Note: Only one version of the In-Sight Display Control can be registered at a time, and this is always the
latest version installed. Although older versions of RobotStudio or In-Sight may seem to function with
this version installed, their compatibility with this version is not guaranteed.

RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated
Vision jobs with the tool PatMax 1-50.

Workaround: Use PatMax 1-10 instead

Remaining error – New Emulators

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of
these new models are not yet fully compatible. Our recommendation is to choose a camera model from
the 7000 series which is fully compatible with Firmware version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the controller is in
Motors On. As a consequence, the camera nodes will not appear in the controller browser.

Workaround: Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision
node in the browser to make the cameras appear.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for
a specific camera model, then the newest version available shall be used. There are two important things
to know before upgrading a sensor:

The user must make sure to first backup the files on the camera. This can be done using the Rapid
snippets for camera backup/restore, or the FlexPendant Explorer.
The latest available firmware version may vary across sensor types. However, when the firmware
update utility presents the latest available version it shows the firmware with the highest version
number which may not apply to the sensor to be updated. However, the appropriate firmware will
be applied.

Information – The spreadsheet view
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The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”,
“Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or
Output to Rapid.

Information – Calibration board without fiducial

When using the calibration boards, checkerboard or board with dots, the user must select the preferred
origin by clicking and accepting (press enter) three points on the board. Only after these three points
have been selected it is possible to click "calibrate" to execute the calibration.

Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions
return error code “Communication Error”. The safest method to get default settings is to go to
Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click
“Apply factory settings” in the lower right corner. The most important settings are:

Telnet port: 23
User: "admin"
Password: ""

Information – User Credentials

It is now possible to create user profiles with different access levels on the camera. For detailed
information about this, please refer to the Integrated Vision User Manual.

Remaining error – Save image on camera

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog
still allows the user to try to do this. The result is that the image is not saved and no error message is
given.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is
not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In

Remaining error – VC started from Controller->Add controller does not detect cameras

A VC that is started from Controller->Add controller does not detect cameras on the network, even if
the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that
the controller is not able to detect new cameras on the network when it is in “Motors On” state. When
the VC is started stand-alone in RobotStudio it is automatically set to “Motors On“ when started.

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or launch the
VC as part of a station.

User tip - Removing cameras from configuration

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter
Configuration->Communication->Application Protocols and remove the desired camera. Perform a
warm start to complete the operation.

User tip – Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on
the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is
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useful when error tracing camera network problems. If a camera does not appear on the network using
the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the
camera receives power from the controller, then cycle power by turning the mains switch.

User tip – Warm start the controller after changing network settings

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect-
>Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will
give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP
address is used and persist, please try a static address instead.

Offline

Point cloud data in JT files can't be imported

Point cloud data in JT files is not imported by RobotStudio.

Issue with collision avoidance for palletizer robots

When configuring collision avoidance for a palletizer robot using RobotWare 6.11, attaching an object to
a mechanism link can result in an error and the configuration will not be loaded.

The YuMi library revision 1 cannot be successfully updated to YuMi revision 2

When opening a Pack&Go file with a station that has a reference to IRB14000_0.5_0.5__01.rslib  you
get the option to update it to the newer IRB14000_0.5_0.5__02.rslib .

The following issues occurs if you select ‘Yes’ and update the model:

The attached parts, for example Smart Grippers, are detached.
The new YuMi robot is not connected to the virtual Controller.
The old YuMi mechanism is converted to a component.

Answer ‘No’ to this question to keep the original revision 1 model and avoid the problems mentioned
above.

RobotStudio needs to be restarted to update a modified library instance

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be
restarted to update the library. Simply re-opening the station is not enough to update the content of
the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded
even though the underlying file has been updated. This is a known limitation and is expensive to fix.
There is a workaround to the problem, which is to restart RobotStudio.

The robot IRB 1600ID 1.55 m / 6kg replaced by IRB 1660ID1.55 m / 6 kg in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to
IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03
cannot upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on
RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically

Workaround: Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead
when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of the logged-in
Windows user. RAPID applications running in a background task will start to execute when the Pack&Go
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file is opened and FlexPendant applications will start to execute when the user starts the Virtual
FlexPendant. A warning message has been added to the Unpack&Work wizard to make the user aware
that only Pack&Go files (.rspag) from trusted sources shall be opened.

Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries
created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02
or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created
in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04

TrueMove path visualization fails for customized zone data

The TrueMove path visualization function only supports predefined zonedata. It will not work for user
defined zonedata.

Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution
when saving the station. For virtual controller systems with the RobotWare options SafeMove or
Electronic Positioning Switches the backup will fail since these systems contain files that are read-only.
As a result, an error message is presented in the output window: <System name>: Backup failed . The
station will be successfully saved but there will be no backup created. Workaround: Ignore the error
message <System name>: Backup failed  and create a manual backup whenever needed. The
RobotStudio Option “Enable automatic backup of controllers in solution” that is available in
”RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup
function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB
14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000
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The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models

As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the
update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or uncomment the following line in the file RobotStudio.exe.config

<add key=”DoublePresentWorkaround” value=”true” />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station
contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller
configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.

Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets
files in the folders:

…\My Documents\RobotStudio\Instruction Templates
…\My Documents\RobotStudio\Code snippets

Workaround: The user has to manually copy the latest files from

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates

and

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets

to the data folder.

I/O signals configured with access level 'DEFAULT'

When IO signals are configured with access level 'DEFAULT', only input signals are possible to set/reset
from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to
‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference
Interface) if the GSI folder structure is missing.

Workaround: Create GSI Folder before starting the VC inside the HOME directory of the system. See the
Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode.
This is the same behavior as in a physical robot controller system. This typically happens when a run-time
error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this
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state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual
mode, and then back to Automatic mode.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing
via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an
Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals.

Conveyor Tracking

*Conveyor objects must be re-added for stations created prior to RS 6.05

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects
must be re-added.

Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual
controller system. The symptom is that its attribute values are all zero, see snapshot below.

Workaround: Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual
controller followed by a restart.

EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
 -Name "c1Position" -SignalType "AI" -Unit "CnvIf"\
 -SignalLabel "ctPosition" -UnitMap "0-31" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647
 -Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -SignalLabel "ctSpeed"\
 -UnitMap "32-63" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647

MultiMove

MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be
displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status
‘Calculation OK’ is displayed. In addition, when ‘Create Paths‘ is pressed the following message is
displayed: ‘Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths
Settings’, is the WP TCP drop down empty.

Reason: Workobject is not set for the current task.

External Axis

Error 50091: ‘Restart not possible’ after warm start of a system with external axis

When restarting a system with activated mechanical units the activation state is lost. Then the program
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can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the program from
the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the
Simulation Play button.

Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents
folder resides on a server and not on the local disk.

Workaround: Redefine the ’User Project Folder’ to a folder on the local disk (File → Options → General →
Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will
cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts.
Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare
mediapool, the following problems may occur:

Virtual controller does not start
Not possible to open Virtual FlexPendant

Cause: By default, the .NET Framework does not allow execution of code from a remote file system. This
means the application may behave unexpectedly if the media used by the system or the system itself
resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in C:\Program Files (x86)\ABB Industrial
IT\Robotics IT\RobotStudio 5.61\Bin

2. Add the following lines:

<?xml version="1.0"?>
<configuration>
    <startup useLegacyV2RuntimeActivationPolicy="true">
        <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
    </startup>
    <runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
        <loadFromRemoteSources enabled="true"/> <!-- THIS IS ONE OF THE NEW LINES!!! -->
    </runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
</configuration>

The Virtual FlexPendant must be restarted for the changes to take effect. For further information, see
http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx

RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice
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versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.

Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly,
i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the
same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled
(PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data name type has same name as existing
object in same block routine.

When this error message appears, there is a storage type mix-up between data already stored in RS and
in the VC. Because of this, and per design, the data is not considered the same data.

Workaround:

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface
for this).

2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus,
will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

Graphics and Geometry

*Display of working range optimized for furthest reach

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The
sweep is not optimized to get the shortest reach on the "inside" of the working area.
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Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can
be configured to use a specified device. By this option you can ensure maximum performance. This is
useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA
card.

Open the file RobotStudio.exe.config that is located in the folders

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin64

and

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin

and uncomment the line:

<add key="GraphicsDeviceType" value="Discrete"/>

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer). Note that there are two different
files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete
the items that caused the problem.

ScreenMaker

Numeric controls and decimal separators

To use numeric controls in ScreenMaker on the PC set the decimal symbol to a single period ('.'). Other
decimal symbols are not supported and binding values will not work in the Virtual FlexPendant. The
behavior on the real FlexPendant is not affected by this PC setting.

Graphs on secondary screens

To use a Graph on a secondary screen (not the main screen) a custom action is needed. Otherwise, the
Graph will not be updated properly. In the ScreenForm that contains the Graph add a Load event. In this
event add an action using Add Action->Advanced->Call Custom Action. Select the Graph control and the
UpdateValues action.
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Binding to the Enabled property

Connecting the Enabled property of any control to a BOOL variable or IO signal may not work as
expected. The variable or signal may be inadvertently changed leading to unexpected behavior. Instead,
bind to a digital output where the Access Level is set to ReadOnly

A ScreenMaker cannot be deployed a controller with disabled Default User

Workaround: Enable the Default User.

NumEditor in ScreenMaker disables the controls in a group box or panel

If you are using the NumEditor control in a group box or a panel, and that box or panel is enabled by an
input signal, then all other controls of that group or panel will become disabled if the editor is opened
and closed.

Button with multiple states in ScreenMaker app do not update the images if button is disabled

For an app which uses Buttons with multiple states connected to images that change depending on the
value of a RAPID variable, then if the button is disabled, the button shows the greyed image of the state
which was active when the disabled state was shown the first time.

ScreenMaker fails for RobotWare 5.12

ScreenMaker fails to build applications for RobotWare 5.12.
Workaround: Update to a later RobotWare version.

A ScreenMaker application may fail to build if the DPI setting is not set to 100%

Certain UI controls in ScreenMaker may fail to build correctly if the DPI setting is not set to ‘Smaller –
100%’.
Symptom: The error message caused by this problem will read ‘System.Drawing.Font’ does not contain a
constructor that takes 2 arguments.
Workaround: Set DPI to 100% on your PC.

File changes to FlexPendant applications does not load the changes until a FlexPendant reset

With RobotWare 6.0x the controller's restart will no longer reset the FlexPendant memory. This was part
of an effort to improve the restart time of the controller. This means that after placing a new

© Copyright 2024 ABB. All rights reserved. 25/29



FlexPendant application file(s) on the FlexPendant unit, you need to manually reset the FlexPendant for
it to reload its assets.

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's backside. (See
Operating Manual – IRC5 with FlexPendant, 3HAC16590)

Running Routine with Movement

RunRoutine Button control does not always work correct when a routine with movements is called. As a
workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the
movements of the robot. A Trap routine could be called with a normal button control and in the Trap the
above instructions can be used to control the movements of the robot.

PictureBox control as a Widget

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not
shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.

© Copyright 2024 ABB. All rights reserved. 26/29



RobotWare Compatibility

Supported RobotWare versions

RobotStudio works with RobotWare 5.07 and later. Please check details below. The latest supported
RobotWare version for IRC5 and OmniCore controllers is stated under Help/About in RobotStudio.
RobotWare packages can be added to RobotStudio from the Add-Ins Gallery window.

RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later
versions. Please use the corresponding version of RobotStudio for managing robot controllers with any
of these RobotWare versions.

RobotWare 5.07 Compatibility

General

The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline

A limitation in the versions 5.07.02, 5.07.03, and, 5.07.04 of RobotWare may cause the Virtual Controller
to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not
being correctly created.
Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then
perform a warm start.
Note: The problem will reappear if the system is I-started. The virtual controller does not support
RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07.

RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:

Offline

RobotWare 5.08 is not supported.
Workaround: Use RobotWare 5.08.01 or later.

RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:

Offline

Starting a controller will generate internal UAS error in controller error log.

RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions of are supported with the following limitations:

Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example,
if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to
stop or to change configuration.
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RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.01 are not compatible with RW 5.12.02 or later. Restoring a paint system
backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later.
Workaround: Add the following parameters to the configuration files:
EIO.CFG

EIO_SIGNAL:
-Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
-Name "A1HVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"\
-Access "ALL"
-Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"\
-Access "ALL"

EIO_CROSS:
-Res "A1HVEn" -Act1 "HVEnabled"

SYS.CFG:

CAB_TASK_MODULES:
-File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"\
-Task "T_ROB1"
-File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask \
-Hidden

RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW
5.13.03. There are several changes in the configuration database for I/O (EIO.CFG) and Controller
(SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed
RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your
original backup, but do not load the backup.

2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file

comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-

system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are

not changed by the user).
7. Load the backup and restart the system. You are done.

RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.
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RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a
system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then
recreate the system and finally, restore the backup. For this reason, the functions ‘Unpack&Work’, ‘Go
Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent
upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01. RobotStudio, however, is compatible with
both RobotWare 6.00 / 6.00.01 and 6.01.

General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or
SafeMove can be done without the need to read track motion parameters manually when using
RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically
read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present
all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or
earlier is used.

Workaround: Upgrade to RW5.14.01 or later

Microsoft Visual C++ 2010/2013 requirement

The redistributables for Microsoft Visual C++ 2010 and 2013 are no longer included in the RobotStudio
installer.
These are required when starting a Virtual Controller using RobotWare 5.x or RobotWare 6.00 - 6.06. If
the requirement is not already installed on the PC, the user will be prompted to download and install it
when such a Virtual Controller is started.
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